Copyright

© Copyright EDAN INSTRUMENTS, INC. 2008. All rights reserved.

Statement

Edan Instruments, Inc. (hereinafter called EDAN) makes no warranty of any kind with regard to this material, including, but not limited to the implied warranties of merchantability and fitness for a particular purpose. EDAN assumes no responsibility for any error that may appear in this document, or for incidental or consequential damage in connection with the furnishing, performance or use of this material.

No part of this document may be photocopied, reproduced or translated to another language without prior written consent of EDAN.

All information contained in this publication is believed to be correct. EDAN shall not be liable for errors contained herein nor for incidental or consequential damages in connection with the furnishing, performance, or use of this material. This publication may refer to information and protected by copyrights or patents and does not convey any license under the patent rights of this company, nor the rights of others. This company does not assume any liability arising out of any infringements of patents or other rights of third parties.

The information contained in this document is subject to change without notice.

Responsibility of the Manufacturer

EDAN only considers itself responsible for any effect on safety, reliability and performance of the equipment if:

Assembly operations, extensions, re-adjustments, modifications or repairs are carried out by persons authorized by EDAN, and

The electrical installation of the relevant room complies with national standards, and

The instrument is used in accordance with the instructions for use.

⚠️ WARNING ⚠️: This device is not intended for treatment.

Upon request, EDAN may provide, with compensation, necessary circuit diagrams, and other information to help qualified technician to maintain and repair some parts, which EDAN may define as user serviceable.

Product Information

Product Name: Ultrasonic Pocket Doppler

Model: SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II, SONOTRAX II Pro
Using This Label Guide

This guide is designed to give key concepts on safety precautions.

⚠️ WARNING ⚠️

A WARNING label advises against certain actions or situations that could result in personal injury or death.

⚠️ CAUTION ⚠️

A CAUTION label advises against actions or situations that could damage equipment, produce inaccurate data, or invalidate a procedure.

Note: A NOTE provides useful information regarding a function or a procedure.
Table of Contents

Chapter 1 Introduction .............................................................................................................. 1
  1.1 Intended Use ................................................................................................................... 1
  1.2 Features ....................................................................................................................... 1
Chapter 2 Safety Guidance ........................................................................................................ 3
  2.1 Safety Precautions ....................................................................................................... 3
  2.2 Symbols ....................................................................................................................... 5
  2.3 Ordering Information ................................................................................................. 5
Chapter 3 Doppler and Accessories .......................................................................................... 7
  3.1 Appearance ................................................................................................................ 7
  3.2 Display Panel ............................................................................................................ 8
  3.3 Buttons ....................................................................................................................... 9
  3.4 Socket ....................................................................................................................... 10
  3.5 Probes ....................................................................................................................... 11
    3.5.1 Waterproof Probes .............................................................................................. 11
    3.5.2 Waterproof Vascular Probes ........................................................................... 11
    3.5.3 Probe Socket ................................................................................................ ...... 12
  3.6 Battery ....................................................................................................................... 13
Chapter 4 Operation ................................................................................................................ 14
  4.1 Opening the Package and Checking .......................................................................... 14
  4.2 Installing Battery ....................................................................................................... 14
  4.3 Probe Operation ....................................................................................................... 15
  4.4 Switch on the Doppler ............................................................................................... 16
  4.5 Modes Setting .......................................................................................................... 16
    4.5.1 Real-time FHR Display Mode (Mode 1) ......................................................... 16
    4.5.2 Averaged FHR Display Mode (Mode 2) ......................................................... 17
    4.5.3 Manual Mode (Mode 3) .................................................................................. 17
    4.5.4 Back Light Brightness Setting Mode (Mode 4) ............................................ 17
    4.5.5 Record Sampling Frequency Setting Mode (Mode 5) ................................... 17
  4.6 Fetal Heart (FH) Monitoring .................................................................................... 18
  4.7 Build-in Recording and Playing ............................................................................... 19
  4.8 Record Fetal Heart Sounds ....................................................................................... 19
    4.8.1 Record Sounds ................................................................................................. 19
    4.8.2 Play Sound Files .............................................................................................. 21
    4.8.3 Burn CD or Send in Email ............................................................................ 21
    4.8.4 Record Troubleshooting ............................................................................... 21
  4.9 Vascular Monitoring (Optional) ............................................................................. 23
  4.10 Switch Off the Doppler ......................................................................................... 25
  4.11 Replacing or charging the battery ........................................................................ 25
Chapter 5 Product Specifications ........................................................................................... 26
Chapter 1 Introduction

1.1 Intended Use

The SONOTRAX Series Ultrasonic Pocket Dopplers are intended to be used by health care professionals including registered nurses, practical nurses, midwives, ultrasound technicians, and physicians assistants, by prescription from licensed physicians in hospitals, clinics and private offices.

The 2 MHz and/or 3 MHz waterproof probes are indicated for the detection of fetal heart rate from early gestation thru delivery and as a general indication of fetal well being. They can also be used to verify fetal heart viability following patient trauma.

The 4 MHz and/or 8 MHz waterproof vascular probes are indicated for the detection of blood flow in veins and arteries for assisting in the detection of peripheral vascular disease.

1.2 Features

There are six different models available: SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro.

SONOTRAX Lite is for simple auscultation (intermittent listening). SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro are not only used to listen in the fetal heart, they also display the fetal heart rate on a LCD screen.

Different model has different feature, refer to the chart below for details:

<table>
<thead>
<tr>
<th>Model</th>
<th>LCD Display</th>
<th>LCD Backlight</th>
<th>Mini USB Probe Socket</th>
<th>Probe Detecting</th>
<th>Probe Identifying</th>
<th>Built-in Speaker</th>
<th>Attached Earphone</th>
<th>Volume Adjustable</th>
<th>Modes Switching</th>
</tr>
</thead>
<tbody>
<tr>
<td>SONOTRAX Lite</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SONOTRAX Basic</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SONOTRAX Basic A</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SONOTRAX Pro</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SONOTRAX II</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SONOTRAX II Pro</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Feature</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio Recording and Playing</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alkaline Battery (9V)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lithium-ion Polymer Battery</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Charge in Machine</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Battery Detecting</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Battery Indicating</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Shutdown</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vascular Monitoring</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 2 Safety Guidance

This unit is internally powered equipment, and the degree of shock protection is type B.

Type B protection means that these person connections will comply with permitted leakage currents, dielectric strengths of IEC/EN 60601-1.

2.1 Safety Precautions

**WARNING** and **CAUTION** messages must be observed. To avoid the possibility of injury, observe the following precautions during the operation of the device.

**WARNING**: This device is not explosion-proof and can not be used in the presence of flammable anaesthetics.

**WARNING**: Do not throw batteries in fire as this may cause them to explode.

**WARNING**: Do not attempt to charge normal alkaline batteries, they may leak, and may cause a fire or even explode.

**WARNING**: Charge the lithium-ion polymer battery with the special charger supplied by EDAN.

**WARNING**: Don’t touch signal input or output connector and the person simultaneously.

**WARNING**: Accessory equipment connected to the analog and digital interfaces must be certified according to the respective IEC/EN standards (e.g. IEC/EN 60950 for data processing equipment and IEC/EN 60601-1 for medical equipment). Furthermore all configurations shall comply with the valid version of the system standard IEC/EN 60601-1-1. Everybody who connects additional equipment to the signal input connector or signal output connector configures a medical system, and is therefore responsible that the system complies with the requirements of the valid version of the system standard IEC/EN 60601-1-1. If in doubt, consult our technical service department or your local distributor.

**WARNING**: SONOTRAX Series Ultrasonic Pocket Doppler is a tool to aid the healthcare professional and should not be used in place of normal fetal monitoring.

**WARNING**: We recommend that exposure to ultrasound should be kept as low as reasonably achievable. This is considered to be good practice and should be observed at all time.

**WARNING**: Replacing battery shall only be done outside the personnel environment (1.5m away from the personnel).

**WARNING**: Please use probes provided by EDAN.
WARNING: The stretching length of probe cable should be less than 2m in order to avoid the cable breaking away from the probe socket.

CAUTION: Federal (U.S.) law restricts this device to sale by or on the order of a physician.

CAUTION: Refer servicing to qualified personnel.

CAUTION: The main unit of the SONOTRAX Series is designed for continuous operation and is ‘ordinary’. Do not immerse in any liquid (i.e. not drip or splash-proof).

CAUTION: Keep the device clean. Avoid vibration.

CAUTION: Do not use high temperature sterilizing process and E-beam or gamma radiation sterilization.

CAUTION: Electromagnetic Interference—Ensure that the environment in which the device is operated is not subject to any source of strong electromagnetic interference, such as radio transmitters, mobile telephones, etc. Keep them far away.

CAUTION: You must check that the equipment does not have visible evidence of damage that may affect personnel's safety or monitoring capability before use. The recommended inspection interval is once per month or less. If damage is evident, replacement is recommended before use.

CAUTION: The following safety checks should be performed once every two years or as specified in the institution's test and inspection protocol by a qualified person who has adequate training, knowledge, and practical experience to perform these tests.

- Inspect the equipment for mechanical and functional damage.
- Inspect the safety relevant labels for legibility.
- Verify that the device functions properly as described in the instructions for use.
- Test the pregnant woman’s leakage current according to IEC/EN 60601-1: Limit: 100 uA (B).

The leakage current should never exceed the limit. The data should be recorded in an equipment log. If the device is not functioning properly or fails any of the above tests, the device has to be repaired.

CAUTION: If the rechargeable button battery is used, please charge it fully before use in order to protect its performance and life. Under normal temperature, the battery should be charged for 14 hours continuously at standard charge circuit.

CAUTION: The battery must be taken out from the battery compartment if the device will not be used for a long time.
SONOTRAX Series Ultrasonic Pocket Doppler User Manual

⚠️ CAUTION ⚠️: The device shall only be used if the battery cover is closed.

⚠️ CAUTION ⚠️: The battery must be proper disposed according to local regulation after their use.

⚠️ CAUTION ⚠️: The device could be sent back to the manufacturer for recycling or proper disposal after their useful lives.

2.2 Symbols

This item is compliant with Medical Device Directive 93/42/EEC of June 14, 1993, a directive of the European Economic Community.

This symbol consisting of two parts, see below.

It indicates that the equipment should be sent to the special agencies according to local regulation for separate collection after its useful life.

It indicates that the equipment is put on the market after 13 August 2005

Attention. Refer to accompanying documents.

Part Number
Serial Number
Date Of Manufacture
Manufacturer
Authorized Representative in the European Community
Recycle

Rx only Federal (U.S.) Law restricts this device to sale by or on the order of a physician

2.3 Ordering Information

The accessories for normal use supplied or approved by EDAN can be used with SONOTRAX Series Ultrasonic Pocket Doppler.
### Accessory and Manufacturer Information

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Manufacturer and Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coupling Gel (0.06litre/0.25litre bottle)</td>
<td>Parker Aquasonic 100 or equivalent, MS2-14019</td>
</tr>
<tr>
<td>2.0MHz Waterproof Probe</td>
<td>EDAN, MS3-14320</td>
</tr>
<tr>
<td>3.0MHz Waterproof Probe</td>
<td>EDAN, MS3-14321</td>
</tr>
<tr>
<td>4.0MHz Waterproof Vascular Probe</td>
<td>EDAN, MS3-14346</td>
</tr>
<tr>
<td>8.0MHz Waterproof Vascular Probe</td>
<td>EDAN, MS3-14347</td>
</tr>
<tr>
<td>Alkaline Battery (9V)</td>
<td>NANFU, M21-64048</td>
</tr>
<tr>
<td>Lithium-ion Polymer Battery (900mAh)</td>
<td>Xwoda Electronics Co. Ltd, M21R-64083</td>
</tr>
<tr>
<td>Line-in Cable</td>
<td>EDAN, M13-36032</td>
</tr>
<tr>
<td>Lithium-ion Polymer Battery Charger</td>
<td>HYENERGY, M21R-64082</td>
</tr>
<tr>
<td>Earphone</td>
<td>EDAN, M13-36041</td>
</tr>
<tr>
<td>Carry Bag</td>
<td>EDAN, MS1-104581</td>
</tr>
<tr>
<td>Carry Bag</td>
<td>EDAN, MS1-14268</td>
</tr>
</tbody>
</table>
Chapter 3 Doppler and Accessories

3.1 Appearance

Take example for 2.0MHz waterproof probe.

Figure 3-1 Front Panel                  Figure 3-2 Rear Panel

Figure 3-3 Top Panel                  Figure 3-4 Left Panel
3.2 Display Panel

There is a LED at the left-bottom corner of the display panel area of SONOTRAX Lite. When powered on, the LED turns into green. If the green LED flashes, it indicates that the probe is disconnected or bad connected. If the LED turns into orange and flashes, it indicates that the battery is too low to support working. Change for a new battery or charge the chargeable battery in time.

For SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro Ultrasonic Pocket Doppler, while self-testing, the LCD display is as follows:

Figure 3-5 LCD display status while self-testing

**Working Mode**: 
Here shows which working mode is the Doppler working on.

**FHR Refresh Frequency**: 
When monitor starts, the heart shape flashes, its frequency indicates the FHR refreshing frequency.

**Battery Indicator**: 
For SONOTRAX Basic, a battery symbol appears on the LCD after powered on, when battery is low, this symbol flashes; the Doppler will shut down automatically after 7 seconds.

For SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro, there are several green panes in the battery symbol on the LCD, which indicates the battery electric energy. The green panes disappear gradually with the energy consumption. When battery is low, the empty symbol flashes for 3 times while a “Di” tone is repeated for 3 times. Then the Doppler shuts down automatically.

**PLAYING**: 
PLAYING is highlighted when the Doppler is playing the recorded audio signals.

**RECORDING**: 
RECORDING is highlighted when the Doppler is recording.

**FHR Displaying:**
Here displays the fetal heart rate value, whose unit is bpm (beat per minute).

**Probe Type:**
The Doppler can detect and identify the probe: when the probe is not connected or not well connected to the Doppler, the “---” symbol and “MHz” symbol on the LCD screen flash; when the probe is well connected, the flashing stops, the probe type displays on the LCD screen.

**Communication**
The Doppler can communicate with PC. This function is reserved.

### 3.3 Buttons

At most there are four push buttons (Power, MODE, START/STOP and REC/PLAY) and a volume control button on the SONOTRAX Series Ultrasonic Pocket Doppler. Their primary functions are as follows:

1. **Power Button**
   - **Function:** Switch on or off the Doppler.

2. **MODE Button**
   - **(Only for SONOTRAX Basic / SONOTRAX Basic A/ SONOTRAX Pro/ SONOTRAX II/ SONOTRAX II Pro)**
   - **Function:** Select the working mode.

3. **START/STOP Button**
   - **(Only for SONOTRAX Basic/ SONOTRAX Basic A/ SONOTRAX Pro/ SONOTRAX II/ SONOTRAX II Pro)**
   - **Function:** Start/ stop monitoring (Mode 3)/ setting (Mode 4 and Mode 5).

4. **REC/PLAY**
   - **(Only for SONOTRAX Pro/ SONOTRAX II Pro)**
   - **Function:** Start/ stop recording or playing.

5. **Volume Control Indicator**
Function: Adjust volume. Rotate the volume gear clockwise to turn up the volume, while rotate it anti-clockwise to turn down the volume.

3.4 Socket

The two sockets are located on the top panel of the Doppler.

(1) Earphone socket: the earphone or line-in cable connects to the Doppler via this socket.

Figure 3-6 Line-in Cable

⚠️: Attention. Refer to the accompanying documents.

Signal Interface

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GND</td>
<td>Signal</td>
<td>Signal</td>
<td>Signal</td>
<td>Signal</td>
</tr>
</tbody>
</table>

(2) Charge socket: the special lithium-ion polymer battery charger connects to the Doppler via this socket. (For SONOTRAX II and SONOTRAX II Pro only)

NOTE: Accessory equipment connected to the analog and digital interfaces must be certified according to the respective IEC/EN standards (e.g. IEC/EN 60950 for data processing equipment and IEC/EN 60601-1 for medical equipment). Furthermore all configurations shall comply with the valid version of the system standard IEC/EN 60601-1-1. Everybody who connects additional equipment to the signal input connector or signal output connector configures a medical system, and is therefore responsible that the system complies with the requirements of the valid version of the system standard IEC/EN 60601-1-1. If in doubt, consult our technical service department or your local distributor.
3.5 Probes

3.5.1 Waterproof Probes

2.0MHz/3.0MHz waterproof probe can be connected with the main unit of the SONOTRAX Series.

The main information on the probe is as follows:
CD2.0/3.0: CD means continuous wave Doppler, 2.0/3.0 means central frequency is 2.0 MHz/3.0MHz.
MS3-14320: Part number of the 2.0MHz waterproof probe.
MS3-14321: Part number of the 3.0MHz waterproof probe.
A: Version number of the probe.
SNxxxxx: Serial number of the probe.
Waterproof: The probe is waterproof.
IPX8: Water Ingress Protection Code, which indicates this probe can work continuously for 5 hours when being immersed into water within 1 meter depth.

3.5.2 Waterproof Vascular Probes

The 4.0MHz (optional) and the 8.0MHz waterproof vascular probes are used for monitoring arteries and veins.
The main information on the probe is as follows.

CD 4.0/CD8.0: CD means continuous wave Doppler, 4.0/8.0 means the central frequency is 4.0/8.0 MHz.

MS3-14346: EDAN part number of 4.0MHz waterproof vascular probe.

MS3-14347: EDAN part number of 8.0MHz waterproof vascular probe.

A: the version number of this vascular probe.

SNxxxxx: Serial number of this vascular probe.

Waterproof: The probe is waterproof.

IPX8: Water Ingress Protection Code, which indicates this probe can work continuously for 5 hours when being immersed into water within 1 meter depth.

### 3.5.3 Probe Socket

Figure 3-11 Probe socket

<table>
<thead>
<tr>
<th>Jack</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power Supply</td>
</tr>
<tr>
<td>2</td>
<td>Signal</td>
</tr>
<tr>
<td>3</td>
<td>Probe Coding 1</td>
</tr>
<tr>
<td>4</td>
<td>Probe Coding 2</td>
</tr>
<tr>
<td>5</td>
<td>Probe Coding 3</td>
</tr>
<tr>
<td>6</td>
<td>(Shell) GND</td>
</tr>
</tbody>
</table>

The probe socket is shown as Figure 3-11.

Connect the 2.0MHz waterproof probe, 3.0MHz waterproof probe, 4.0MHz waterproof vascular probe or 8.0MHz waterproof vascular probe developed by EDAN to the SONOTRAX Series according to real requirements.

⚠️ **WARNING**: Do not try to connect any other plug to the probe socket except the plug of the probes mentioned above.

⚠️ **WARNING**: In case of disengaging from the probe interface, the connecting cable of the probe can not be dragged for more than 2 meters.
3.6 Battery

Power of the SONOTRX Lite, SONOTRX Basic, SONOTRX Basic A and SONOTRX Pro Doppler comes from a 9V alkaline battery (IEC Type No. 6LR61/6LF22 or equivalent).

Power of the SONOTRX II and SONOTRX II Pro Doppler comes from a lithium-ion polymer battery supplied by EDAN.
Chapter 4 Operation

NOTE: To ensure that the Doppler would work properly, please read this chapter and 
Chapter 1 Safety Guidance before operating; follow the steps when 
connecting all the components.

4.1 Opening the Package and Checking

Open the package; take out the Doppler and accessories carefully. Keep the package for 
possible future transportation or storage. Check the components according to the packing list. 
A Check for any mechanical damage. 
A Check all the cables and accessories. 
If there is any problem, contact us or your local distributor immediately.

4.2 Installing Battery

1. Open the battery compartment. 
   Turn the rear panel up. Press the top stripe symbols of the compartment cover hard with 
one thumb. Meanwhile slide the cover out along the direction of arrowhead with the other 
thumb (figure 4-1). 
   Figure 4-1 Remove the compartment cover

2. Place the battery. 
   For SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A and SONOTRAX Pro 
Doppler, there is a battery connector that has been inserted to the battery socket in the 
compartment. Take out a new battery and connect the battery to the connector; put the 
assembly back into the compartment with the connector inward.
For SONOTRAX II and SONOTRAX II Pro Doppler, insert the plug of the lithium-ion polymer battery into the battery socket and put them into the compartment with the wires inward.

3. Slide the compartment cover back to close the compartment.

⚠️ CAUTION ⚠️: Take out the battery and keep it in cool and dry environment if the Doppler will not be used for a long time.

⚠️ CAUTION ⚠️: For the lithium-ion polymer battery, charge it in the machine with the special charge when its power is low. Do not charge it with other charges or remove it frequently.

### 4.3 Probe Operation

1. **Taking out Probe**

   Hold the Doppler main unit with one hand, and hold the top of the probe with another hand (Figure 4-2). First take out the top of the probe (Figure 4-3). Then take out the whole probe from the probe frame (Figure 4-4).

2. **Placing Probe**

   Follow the opposite steps to take out the probe.

   Hold the main unit with one hand, and hold the top of the probe with another hand (Figure 4-4). Place the probe from the middle of the unit (at the right) into the probe holder (Figure 4-3), then push the top of the probe (Figure 4-2).

⚠️ CAUTION ⚠️: Do not take out or place the probe when the Doppler is on. Remember to take out the probe before switching on the Doppler, and place the probe after switching off the Doppler.
(3) Removing and Connecting a Probe

One probe has been connected to SONOTRAX Series ultrasonic pocket Doppler while packed by the manufacturer. If you need to replace it with another probe, take out the probe first; then pull out the plug of the probe from its socket (figure 4-5). Connect the plug of another probe to the socket and then the probe can be used.

Figure 4-5 Remove the Probe

NOTE: Place the temporarily unused probe carefully and avoid falling off, splash or stress, etc. When the Doppler is not used for a long time, it’s recommended to connect the probe to the Doppler and keep them safely in the package.

4.4 Switch on the Doppler

Press the POWER button on front panel to switch on the Doppler.

4.5 Modes Setting

SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro Dopplers have a number of mode options. Press the MODE button to switch to the next mode.

If the SONOTRAX Basic/ SONOTRAX Basic A/ SONOTRAX Pro/ SONOTRAX II/ SONOTRAX II Pro Doppler worked on Mode 1/ Mode 2/ Mode 3 last time before shutdown, after self-testing, the Doppler will enter the same mode automatically. If its last mode is Mode 4/ Mode 5, it will enter Mode 1 after self-testing.

4.5.1 Real-time FHR Display Mode (Mode 1)

When the Doppler works on this mode, the Working Mode on LCD displays 1.

As soon as a fetal heart signal is detected, the heart shape on LCD flashes, the FHR display area displays the real-time FHR value.
4.5.2 Averaged FHR Display Mode (Mode 2)

When the Doppler works on this mode, the Working Mode on LCD displays 2. The heart shape on LCD flashes when fetal heart signal is detected, the FHR value indicates the average value of 8 beats, which changes slowly.

4.5.3 Manual Mode (Mode 3)

When the Doppler works on this mode, the Working Mode on LCD displays 3. Press START/STOP button once and immediately start counting, count 1 on the moment when the button is pressed. The LCD displays the flashing heart shape symbol and “---”. Press the button again on the 10th count (after 9 beat intervals).

The Doppler automatically calculates the derived FHR averaged over the 10 beat periods and displays the result. This rate value will not disappear until another measurement starts or the mode is changed.

4.5.4 Back Light Brightness Setting Mode (Mode 4)

This mode is only for SONOTRAX Basic A/ SONOTRAX Pro/ SONOTRAX II/ SONOTRAX II Pro.

When the Doppler works on this mode, the Working Mode on LCD displays 4. Press START/STOP button to set the brightness of white back light. “OFF” displayed at the LCD means the white back light is disabled, while “ON” means the white back light is enabled.

NOTE: The setting under this mode will be saved automatically after mode switching or normal power off.

4.5.5 Record Sampling Frequency Setting Mode (Mode 5)

SONOTRAX Pro/ SONOTRAX II Pro Doppler have the build-in function of recording and playing audio signals, this mode is used to set the record sampling frequency.

When the Doppler works on this mode, the Working Mode on LCD displays 5. Press START/STOP button, the sampling frequency switches between 4 and 8 on the LCD. “4” means the frequency is 4KHz, the longest record time is 480 seconds; while “8” means 8KHz, the longest record time is 240 seconds.

NOTE: (1) The setting under this mode will be saved automatically after mode switches or normal power off.

(2) After changing frequency, the records related to the original frequency will be cleared automatically.
4.6 Fetal Heart (FH) Monitoring

FH monitoring with 2.0MHz waterproof probe or 3.0MHz waterproof probe

Feel the position of the fetus by hand firstly to find out the best direction to the fetal heart. Apply a liberal amount of gel to the faceplate of probe; place the faceplate of probe at the best position for detecting fetal heart. Adjust the probe to obtain an optimum audio signal ideally by angling the probe around. Adjust the volume according to requirements. Refer to figure 4-6.

Figure 4-6 FH monitoring

The audio fetal heart beat is sent out via the built-in speaker or attached earphone; the FHR value is displayed on the LCD (except SONOTRAX Lite).

NOTES:

1) The best quality records will only be obtained if the probe is placed in the optimum position.

2) Positions with strong placental sounds (swishing) or fetal cord pulse (indistinct pulse at fetal rate) should be avoided.

3) If the fetus is in the cephalic position and the mother is supine, the clearest heart sound will normally be found on the midline below the umbilicus. During monitoring prolonged lying in the supine position should be avoided owing to the possibility of supine hypotension. Sitting up or lateral positions are preferable and may be more comfortable to the mother.

4) It is not possible to FHR unless an audible fetal heart signal is present. The fetal pulse can be distinguished from the maternal pulse by feeling the mother’s pulse during the examination.
4.7 Build-in Recording and Playing

This function is only for SONOTRAX Pro/SONOTRAX II Pro.

**Recording:** Press the REC/PLAY button and hold for 3 seconds under mode 1, 2 or 3, the machine starts recording, “RECORDING” will appear on the LCD. The longest record time depends on the recording sampling frequency set in mode 5. The machine records 480 seconds with 4KHz frequency and 240 seconds signal with 8KHz frequency.

The machine will stop recording and return to monitoring status when the limited time is over or when you press the REC/PLAY button again.

**Playing:** Press the REC/PLAY button under mode 1, 2 or 3 when the machine is not recording, “PLAYING” will appear on the LCD, the machine plays the recorded signals. When playing is over or pressing the REC/PLAY button again it will return to the monitoring status.

4.8 Record Fetal Heart Sounds

The fetal heart sound signal can be transferred to a personal computer (PC) and recorded by its Sound Recorder. You can play the recorded sound files, burn them into CDs or e-mail them to whomever you want.

4.8.1 Record Sounds

Insert one plug of the special audio cable supplied by the manufacturer to the audio input socket (socket with the symbol “”) of the PC, refer to figure 4-7. If the PC has no audio input socket, insert the plug into the microphone socket (socket with the symbol “”).

Figure 4-7 The Audio Input Socket on the PC
Turn on the PC; startup the sound recorder (Click “Start” → “Programs” → “Accessories” → “Entertainment” → “Sound Recorder”). Refer to figure 4-8.

Figure 4-8 Startup the Sound Recorder

Monitor the FHR with the method described in section 4.6. When the ideal signal is detected, unplug the earphone first if it’s connected; insert the other plug of the audio cable into the earphone socket on the Doppler.

Figure 4-9 The Sound Recorder

Click **Start** to start recording, refer to figure 4-9.

You can record 60 seconds every time, when time is up, click **Start** again to keep on recording.

Click **Stop** to stop recording, refer to figure 4-10.

Click “**File**” → “**Save**”, input the file name, select a folder and click **Save**.

To start a new recording, click “**File**” → “**New**.”
4.8.2 Play Sound Files

The recorded sounds are saved as a waveform (.wav) file in your computer. You can play the waveform file in Sound Recorder. Startup the Sound Recorder, click “File” → “Open”, search for the folder and select the file, click Open to load the file, click Play.

If you have any other program that supports waveform (.wav) files installed on your PC, double click the file to play it.

4.8.3 Burn CD or Send in Email

The waveform files saved in your PC are normal audio data files. You can burn them into CDs or e-mail to whomever you want.

4.8.4 Record Troubleshooting

If there is audio output from the speaker or earphone, but when recording starts, no sound is input. (The green line recording area has no waveform.) The reason could be:

1. The plug of audio cable is not well connected to the Doppler or the PC socket. Re-connect the cable if this condition is detected.

2. The plug of audio cable has been inserted to the wrong socket of the PC, instead of the audio input socket or the microphone socket. Insert the plug to the right socket if this condition is detected.

3. The Line in or microphone is muted on PC. If this condition is detected, change the setting of the PC in these steps:
   a) Double click the volume symbol on the right bottom corner;

   b) The Volume Control menu pops up:
c) If the Line In or microphone volume control is not shown in the Volume Control menu, click “Options” → “Properties”, tick the Line In and Microphone as shown in figure 4-12, click OK:

Figure 4-12 Properties
d) Undo the tick of Line In and Microphone Mute, click \(\times\) to exit.

![Volume Control](image)

e) Start a new recording.

### 4.9 Vascular Monitoring (Optional)

If the SONOTRAX Series Ultrasonic Pocket Dopplers are connected with 4MHz or 8MHz probes, they can be used to do vascular monitoring, which meets most arterial and venous assessment applications, including helping to detect arterial and venous disease, arterial and venous flow studies and other application where detection of blood flow is important.

Choose appropriate probe as needed. The 8MHz probe has better resolution and wider detecting range than the 4MHz probe, but the 4MHz has a deeper detecting depth.

Apply a liberal amount of gel on the site to be examined. Place the probe at 45° to the skin surface over the vessel to be examined. Adjust the position of the probe to obtain the loudest audio signal. Refer to figure 4-13 for the probe sites:
For best results, keep the probe as still as possible once the optimum position has been found. Adjust the audio volume as required. High pitched pulsatile sounds are emitted from arteries while veins emit a non-pulsatile sound similar to a rushing wind.

Vascular monitoring provides audio signals of arteries and veins. If it is done with SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II or SONOTRAX II Pro, the figure displayed on the LCD screen is null.
4.10 Switch Off the Doppler

When the monitor is finished, wipe off the remaining gel off the probe with a clean soft cloth, then put the probe back into the probe frame.

Press the **POWER** button on the SONOTRAX Lite again to switch it off.

If there is no signal input or no operation done to SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro for 60 seconds, it will automatically shut down. Or you can press and hold the **POWER** button for 3 seconds to switch it down manually.

4.11 Replacing or charging the battery

When the Doppler gives out alarm indicating the battery power is low, you have to shut down the Doppler to replace or charge the battery.

For SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A and SONOTRAX Pro Doppler, follow the reverse order of installing a battery described in section 4.2 to replace the battery.

For SONOTRAX II and SONOTRAX II Pro Doppler, charge their lithium-ion polymer battery in the machine by inserting the DC plug of the special charger supplied by EDAN in to the charge socket on the Doppler and connecting the AC plug of it to the a.c.110-240V, 50/60 Hz power supply.

It takes about 4 hours to fully charge the battery. When charging, the LED of the charger is orange; when the battery is fully charged, the LED turns to green.

⚠️ **CAUTION**: Make sure the Doppler is shutdown before charging the battery or opening the battery compartment.

⚠️ **CAUTION**: Only charge the lithium-ion polymer batter of SONOTRAX II and SONOTRAX II Pro in the machine. Do not use the Doppler for monitoring until the charger is disconnected with the Doppler.
Chapter 5 Product Specifications

Product Name: Ultrasonic Pocket Doppler

Model: SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II, SONOTRAX II Pro

Safety:

Classification:
Anti-electric Shock Type: Internally powered equipment

Anti-electric Shock Degree: Type B equipment

Degree of Protection against Harmful Ingress of Water:
Main Unit: Non-protected
2.0MHz Waterproof Probe, 3.0MHz Waterproof Probe, 4.0MHz Waterproof Vascular Probe, 8.0MHz Waterproof Vascular Probe: IPX8 Water Ingress Protection Code, which indicates this probe can work continuously for 5 hours when being immersed into water within 1 meter depth.

Degree of Safety in Presence of Flammable Gases: Equipment not suitable for use in presence of flammable gases

Working System: Continuous running equipment

EMC: Group I Class B

Physical Characteristic:
Size: 32 (Depth) x 85 (Width) x 138 (Height) mm
Weight: 290±5g (including a battery and a probe)

Environment:
Working:
Temperature: +5°C ~ +40°C
Humidity: ≤80%
Atmospheric Pressure: 860hPa ~ 1060hPa

Transport and Storage:
Temperature: -10°C ~ + 55°C
Humidity: ≤93%
Atmospheric Pressure: 860hPa ~ 1060hPa

Display: 45*25mm LCD display

FHR Performance:
Sensitivity: 10 weeks gestation
FHR Measuring Range: 50bpm ~ 210bpm
Resolution: 1bpm
Accuracy: ±3bpm

**Audio Output Power:** 0.5W

**Recording and Playing:**
- Audio Sampling Frequency: 4KHz / 8KHz
- Recording Length: 480s / 240s
- Recording can be played

**White Back Light:**
- Two Brightness Adjustable: OFF, ON

**Audio Output Power:** 0.5W

**Auto Shut down:**
- After 1 minute no signal or no operation, auto shut down

**Battery Type Recommended:**
- 9 volt DC alkaline battery (IEC Type No. 6LR61/6LF22 or equivalent).

**Stand-by Time (hour):**

<table>
<thead>
<tr>
<th>9V Alkaline Battery</th>
<th>SONOTRAX Lite</th>
<th>&gt;10 hours</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SONOTRAX Basic</td>
<td>&gt;13 h</td>
</tr>
<tr>
<td></td>
<td>SONOTRAX Basic A</td>
<td>&gt;8 h (with backlight), &gt;13 h (without backlight)</td>
</tr>
<tr>
<td></td>
<td>SONOTRAX Pro</td>
<td>&gt;8 h (with backlight), &gt;13 h (without backlight)</td>
</tr>
<tr>
<td>Lithium-ion Polymer Battery</td>
<td>900mAh</td>
<td>&gt;15 h (with backlight), &gt;24 h (without backlight)</td>
</tr>
</tbody>
</table>

**Lithium-ion Polymer Battery**

<table>
<thead>
<tr>
<th>Type:</th>
<th>Lithium-ion Polymer Battery</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Capacity:</td>
<td>900mAh</td>
</tr>
<tr>
<td>Nominal Voltage:</td>
<td>7.4V</td>
</tr>
<tr>
<td>Charge Mode:</td>
<td>Constant current / Constant voltage</td>
</tr>
<tr>
<td>Charge Current (Standard):</td>
<td>300mA</td>
</tr>
<tr>
<td>Charge Voltage (Standard):</td>
<td>8.4V</td>
</tr>
<tr>
<td>Storage Temperature:</td>
<td>-20°C ~ 40°C (3 months)</td>
</tr>
<tr>
<td>Circle Life:</td>
<td>-20°C ~ 60°C (1 month) ≥500 times, 80% capacity</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------</td>
</tr>
</tbody>
</table>

### Ultrasound

<table>
<thead>
<tr>
<th>Nominal Frequency</th>
<th>2.0MHz Waterproof Probe</th>
<th>2.0MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3.0MHz Waterproof Probe</td>
<td>3.0MHz</td>
</tr>
<tr>
<td></td>
<td>4.0MHz Waterproof Vascular Probe</td>
<td>4.0MHz</td>
</tr>
<tr>
<td></td>
<td>8.0MHz Waterproof Vascular Probe</td>
<td>8.0MHz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Working Frequency</th>
<th>2.0MHz Waterproof Probe</th>
<th>2.0MHz ± 10%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3.0MHz Waterproof Probe</td>
<td>3.0MHz ± 10%</td>
</tr>
<tr>
<td></td>
<td>4.0MHz Waterproof Vascular Probe</td>
<td>4.0MHz ± 10%</td>
</tr>
<tr>
<td></td>
<td>8.0MHz Waterproof Vascular Probe</td>
<td>8.0MHz ± 10%</td>
</tr>
</tbody>
</table>

- \( p < 1 \text{MPa} \)
- \( I_{\text{ob}} < 10 \text{mW/cm}^2 \)
- \( I_{\text{ssa}} < 100 \text{mW/cm}^2 \)

<table>
<thead>
<tr>
<th>Working Mode</th>
<th>Continuous wave Doppler</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Effective Radiating Area of Transducer</th>
<th>2.0MHz Waterproof Probe</th>
<th>245 mm² ± 15%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3.0MHz Waterproof Probe</td>
<td>245 mm² ± 15%</td>
</tr>
<tr>
<td></td>
<td>4.0MHz Waterproof Vascular Probe</td>
<td>32 mm² ± 15%</td>
</tr>
<tr>
<td></td>
<td>8.0MHz Waterproof Vascular Probe</td>
<td>14 mm² ± 15%</td>
</tr>
</tbody>
</table>

### Low Output Summary Table

(for systems with no transducers having global maximum index values exceeding 1.0)

System: Sonotrax series Ultrasonic Pocket Doppler

<table>
<thead>
<tr>
<th>Transducer Model (MHz)</th>
<th>( I_{\text{ssa}} ) (mW/cm²)</th>
<th>TIS Type</th>
<th>TI Value</th>
<th>MI</th>
<th>( I_{\text{ssa}} ) (W/cm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CW 2.0</td>
<td>47.227</td>
<td>TIS</td>
<td>0.20</td>
<td>0.03948</td>
<td>47.227</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TIB</td>
<td>0.19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CW 3.0</td>
<td>2.314</td>
<td>TIS</td>
<td>0.014</td>
<td>0.0049</td>
<td>2.314</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TIB</td>
<td>0.17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CW 4.0</td>
<td>28.3372</td>
<td>TIS</td>
<td>0.01</td>
<td>0.0148</td>
<td>28.3372</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TIB</td>
<td>0.13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CW 8.0</td>
<td>127.125</td>
<td>TIS</td>
<td>0.08</td>
<td>0.0258</td>
<td>127.125</td>
</tr>
</tbody>
</table>
Chapter 6 Maintenance

6.1 Maintenance

The probe acoustic surface is frangible and must be handled with care. Gel must be wiped from the probe after use. These precautions will prolong the life of the unit.

You must check that the equipment does not have visible evidence of damage that may affect the pregnant woman’s safety or SONOTRAX Series capability before use. The recommended inspection interval is once per month or less. If damage is evident, replacement is recommended before use.

The equipment should undergo periodic safety testing to insure proper personnel isolation from leakage currents. This should include leakage current measurement. The recommended testing interval is once every two years or as specified in the institution’s test and inspection protocol.

The accuracy of FHR is controlled by the equipment and can not be adjusted by user. If the FHR result is distrustful, please use other method such as stethoscope to verify immediately or contact local distributor or manufacturer to get help.

6.2 Cleaning

Before cleaning, switch off the power and take out the batteries. Keep the exterior surface of the device clean and free of dust and dirt, clean exterior surface (display screen included) of the unit with a dry, soft cloth. If necessary, clean it with a soft cloth soaked in a solution of soap, or water and wipe dry with a clean cloth immediately.

Wipe the probe with soft cloth to remove any remaining coupling gel. Clean with soap and water only.

⚠️ CAUTION⚠️: Don't use strong solvent, for example, acetone.

⚠️ CAUTION⚠️: Never use an abrasive such as steel wool or metal polish.

⚠️ CAUTION⚠️: Do not allow any liquid to enter the product, and do not immerse any part of the device into any liquid.

⚠️ CAUTION⚠️: Avoid pouring liquids on the device while cleaning.

⚠️ CAUTION⚠️: Don't remain any cleaning solution on the surface of the device.

NOTE: Wipe the surface of probe with 70% ethanol or isopropanol alcohol, self-air dry, or clean with a clean, dry cloth.
6.3 Disinfection

Clean the equipment exterior surface, probe, etc. as above. For the disinfecting of 2.0MHz waterproof probe/ 3.0MHz waterproof probe, immerse the probe into the solutions of Benzalkonium Bromide, 0.5% Chlorhexidine, 2% Glutaraldehyde or 75% ethanol to disinfect. Wipe the probe with a clean, dry cloth to remove any remaining moisture.

**NOTE:** Please pay attention to the height when the probe is immersed in order to prevent the sterilant from entering the probe socket.

⚠️ **CAUTION** ⚠️: Never try to sterilize the probe or equipment by low temperature steam or other methods.
Chapter 7 Warranty and After-Sales Service

7.1 Warranty
EDAN’s obligation under this warranty is limited to repairing, at EDAN’s option, any part which upon EDAN's examination proves defective. If the product doesn't function as warranted during the warranty period, we will repair or replace it without charge.

Material and Manufacture
EDAN warrant that there’s no defect in material and manufacture. During the warranty period, EDAN will repair or replace the defective part free if the defect has been confirmed as material or manufacture defect.

Software or Firmware
EDAN software and firmware products which are designated by EDAN for use with a hardware product, when properly installed on that hardware product, are warranted not to fail to execute their programming instructions due to defects in materials and workmanship. If EDAN receives notice of such defects during the warranty period that begins on the date of shipment, EDAN shall repair or replace software media or firmware which does not execute their programming instructions due to such defects. But EDAN doesn’t warrant that operating of the hardware, software, or firmware shall be uninterrupted or free from error.

Note: The charges of freight and others are excluded under warranty.
This unit has no parts can be repaired by users themselves. All the service should be performed by authorized and qualified personnel.

Limit of Warranty
The warranty is void in the case of

- Assembly, extensions, readjustments of any parts;
- Modification and repair by unauthorized persons;
- Subsequent damage caused by improper use or maintenance;
- Replacement or remove of Serial number label and manufacturer label;

7.2 After-Sales Service
If you have any question about maintenance, technical specifications or malfunctions of devices, contact your local distributor or EDAN service department.

Call us at: +86-755-26898321, 26899221
Fax us at: +86-755-26882223, 26898330
Or send email to: support@edan.com.cn
Appendix 1 EMC Information-Guidance and Manufacture’s Declaration

A1.1 Electromagnetic Emissions - for all Equipment and Systems

<table>
<thead>
<tr>
<th>Emission test</th>
<th>Compliance</th>
<th>Electromagnetic environment–guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions CISPR 11</td>
<td>Group 1</td>
<td>The SONOTRAX Series Ultrasonic Pocket Doppler uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>RF emission CISPR 11</td>
<td>Class B</td>
<td>The SONOTRAX Series Ultrasonic Pocket Doppler is suitable for use in all establishments, including domestic establishments and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
</tbody>
</table>
## A1.2 Electromagnetic Immunity - for all Equipment and Systems

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic environment specified below. The customer or the user of the device should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment-guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD) IEC 61000-4-2</td>
<td>±6 kV contact ±8 kV air</td>
<td>±6 kV contact ±8 kV air</td>
<td>Floors should be wood, concrete or ceramic tile. If floor are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
</tbody>
</table>
A1.3 Electromagnetic Immunity - for all Equipment and Systems that are not Life-supporting

Guidance and manufacture’s declaration – electromagnetic immunity

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic environment specified below. The customer or the user of the device should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment-guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radiated RF</td>
<td>IEC 61000-4-3</td>
<td>3 V/m 80 MHz to 2.5 GHz</td>
<td>3 V/m Portable and mobile RF communications equipment should be used no closer to any part of the SONOTRAX Series Ultrasonic Pocket Doppler, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter. Recommended separation distance</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$d = \frac{3.5}{E_1} \sqrt{P}$ 80 MHz to 800 MHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$d = \frac{7}{E_1} \sqrt{P}$ 800 MHz to 2.5 GHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Where $P$ is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and $d$ is the recommended separation distance in metres (m). Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, should be less than the compliance level in each frequency range. Interference may occur in the vicinity of equipment marked with the following symbol:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>![Symbol]</td>
</tr>
</tbody>
</table>

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the SONOTRAX Series Ultrasonic Pocket Doppler is used exceeds the applicable RF compliance level above, the SONOTRAX Series Ultrasonic Pocket Doppler should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as reorienting or relocating the SONOTRAX Series Ultrasonic Pocket Doppler.

Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
A1.4 Recommended Separation Distances

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter (W)</th>
<th>Separation distance according to frequency of transmitter (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>80 MHz to 800 MHz</td>
</tr>
<tr>
<td></td>
<td>( d = \left[ \frac{3.5}{E_i} \right] \sqrt{P} )</td>
</tr>
<tr>
<td>0.01</td>
<td>0.1167</td>
</tr>
<tr>
<td>0.1</td>
<td>0.3689</td>
</tr>
<tr>
<td>1</td>
<td>1.1667</td>
</tr>
<tr>
<td>10</td>
<td>3.6893</td>
</tr>
<tr>
<td>100</td>
<td>11.6667</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distances in metres (m) can be estimated using the equation applicable to the frequency of the transmitter, where \( P \) is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
### Appendix 2 Overall Sensitivity

**Overall Sensitivity (2MHz Probe)**

<table>
<thead>
<tr>
<th>Diameter of Target Reflector (mm)</th>
<th>Distance (d) (mm)</th>
<th>Reflection Loss A(d)</th>
<th>Two-way Attenuation ( B=\sum B_a+B_w )</th>
<th>( V_r ) (r.m.s.) mV</th>
<th>( V_a ) (r.m.s.) mV</th>
<th>( C=20\log_{10}\left( \frac{V_r}{V_a} \right) ) dB</th>
<th>Overall Sensitivity (S=A(d)+B+C) dB</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>50</td>
<td>45.7</td>
<td>( T ) 20 4.8 4.0 -</td>
<td>0 57.6</td>
<td>186</td>
<td>94</td>
<td>5.93</td>
</tr>
<tr>
<td></td>
<td>75</td>
<td>45.7</td>
<td>( T ) 20 4.8 3.4 -</td>
<td>0 56.4</td>
<td>175</td>
<td>90</td>
<td>5.78</td>
</tr>
<tr>
<td>1.58 A=45.7dB@2MHz</td>
<td>100</td>
<td>45.7</td>
<td>( T ) 20 4.8 3.4 -</td>
<td>0 56.4</td>
<td>174</td>
<td>89</td>
<td>5.82</td>
</tr>
<tr>
<td></td>
<td>200</td>
<td>45.7</td>
<td>( T ) 20 4.8 - -</td>
<td>0 49.6</td>
<td>173</td>
<td>90</td>
<td>5.68</td>
</tr>
<tr>
<td>2.38 A=43.2dB@2MHz</td>
<td>50</td>
<td>43.2</td>
<td>( T ) 20 4.8 3.4 2.2</td>
<td>0 60.8</td>
<td>178</td>
<td>89</td>
<td>6.02</td>
</tr>
<tr>
<td></td>
<td>75</td>
<td>43.2</td>
<td>( T ) 20 4.8 3.4 1</td>
<td>0 58.4</td>
<td>170</td>
<td>90</td>
<td>5.52</td>
</tr>
<tr>
<td></td>
<td>100</td>
<td>43.2</td>
<td>( T ) 20 4.8 3.4 -</td>
<td>0 56.4</td>
<td>165</td>
<td>85</td>
<td>5.76</td>
</tr>
<tr>
<td></td>
<td>200</td>
<td>43.2</td>
<td>( T ) 20 4.8 1 -</td>
<td>0 51.6</td>
<td>160</td>
<td>85</td>
<td>5.49</td>
</tr>
</tbody>
</table>

Doppler Frequency (Hz) 333

Velocity of Target (cm/s) 12.5
## Overall Sensitivity (3.0 MHz Probe)

<table>
<thead>
<tr>
<th>Diameter of Target Reflector (mm)</th>
<th>Distance (d) (mm)</th>
<th>Reflection Loss A(d) (dB)</th>
<th>Two-way Attenuation B=∑B_a+B_w</th>
<th>V_a (r.m.s.) (mV)</th>
<th>V_u (r.m.s.) (mV)</th>
<th>C = 20log10\left(\frac{F_{(r.m.s)}}{F_{(r.m.s)}}\right) (dB)</th>
<th>Overall Sensitivity (S=A(d)+B+C) (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.58 A=44.5dB@3MHz</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>B_a=43.6 17.9 - -</td>
<td>0</td>
<td>61.5</td>
<td>179 90 5.97</td>
<td>111.9</td>
</tr>
<tr>
<td></td>
<td>75</td>
<td></td>
<td>T=10 4 - -</td>
<td>0</td>
<td>57.2</td>
<td>186 94 5.93</td>
<td>107.63</td>
</tr>
<tr>
<td></td>
<td>100</td>
<td></td>
<td>T=10 3 - -</td>
<td>0</td>
<td>57.2</td>
<td>173 88 5.87</td>
<td>107.5</td>
</tr>
<tr>
<td></td>
<td>200</td>
<td></td>
<td>T=10 1 - -</td>
<td>0</td>
<td>50.2</td>
<td>171 89 5.67</td>
<td>100.3</td>
</tr>
<tr>
<td>2.38 A=42.0dB@3MHz</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>B_a=43.6 17.9 - -</td>
<td>0</td>
<td>61.5</td>
<td>194 88 6.73</td>
<td>110.2</td>
</tr>
<tr>
<td></td>
<td>75</td>
<td></td>
<td>T=10 4 - -</td>
<td>0</td>
<td>57.2</td>
<td>172 87 5.92</td>
<td>105.1</td>
</tr>
<tr>
<td></td>
<td>100</td>
<td></td>
<td>T=10 2 - -</td>
<td>0</td>
<td>53.2</td>
<td>165 85 5.76</td>
<td>100.9</td>
</tr>
<tr>
<td></td>
<td>200</td>
<td></td>
<td>T=10 1 - -</td>
<td>0</td>
<td>50.2</td>
<td>160 84 5.59</td>
<td>97.8</td>
</tr>
</tbody>
</table>

**Doppler Frequency (Hz)** 500  
**Velocity of Target (cm/s)** 12.5